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FOCUS OF THIS GUIDE

Our focus with this Guide is to show you how to use OmniFocus® for your GTD® workflow. The Guide is packed 
with our best practices for configuring and populating OmniFocus for your Projects, Next Actions, Waiting For, 
Someday/Maybe, and Reference lists. We’ll also cover strategies for managing your calendar and email. The 
Guide focuses primarily on the Desktop version and touches upon the Web version. 

If you are new to OmniFocus, this Guide should be an excellent starting point for you to build a solid GTD 
foundation for optimizing your productivity. If you already have an established system in OmniFocus, use this 
Guide as an opportunity to fine-tune or simplify, if you have found you’ve underused or overbuilt your setup.

This is not a technical Guide, nor will it cover all the instructions for how to use OmniFocus. We’ll leave that to the  
folks at The Omni Group to share with you through their excellent support material.

There are many ways you could configure OmniFocus for GTD. This Guide focuses on the methods we have 
found work well for GTD for a wide range of people. It’s also important to note that no one tool will handle all 
of your needs for GTD, including OmniFocus. Even with your lists managed in OmniFocus, you’ll still have your 
calendar and email in other programs.

Whatever configuration you choose in tools like OmniFocus, be careful not to overcomplicate it to the point 
where you can only maintain it when you are at your peak of mental clarity. It’s too easy to have a complicated 
system fall apart when you’re not at your best. Your GTD tools should be complex enough to manage your 
workflow, but simple enough that if you were sick in bed with the flu, you could still easily maintain them.

Don’t worry about using every available feature in OmniFocus (or any of your tools for that matter). There may  
be more offered than you will ever need. Focus on what makes a difference for you. 

OK…let’s get started!

Be careful not to overcomplicate your 
systems to the point where you can 
only maintain them when you are  
at your peak of mental clarity.

FOCUS OF THIS GUIDE
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UNDERSTANDING THE GTD BEST PRACTICES

1 Getting Things Done: The Art of Stress-Free Productivity; Viking, New York; 2001, 2015 hardback or paperback. Available from booksellers everywhere.

To get the most out of OmniFocus® as a tool for your GTD practice, let’s review the fundamentals of the Getting 
Things Done® approach, so you understand how the methodology and tools will intersect.

WHAT IS GTD?
GTD is the shorthand brand for “Getting Things Done”, the groundbreaking work-life management system and 
bestselling book1 by David Allen, which provides concrete solutions for transforming overwhelm and uncertainty 
into an integrated system of stress-free productivity.

GTD’S FIVE STEPS OF MASTERING WORKFLOW
CAPTURE 	 Collect anything and everything that’s grabbing your attention.

CLARIFY 	 Define actionable things into concrete next steps and successful outcomes.

ORGANIZE 	Sort information in the most streamlined way, in appropriate categories,  
		  based on how and when you need to access it.

REFLECT 	 Step back to review and update your system regularly. 

ENGAGE 	 Make trusted choices about what to do in any given moment.

THREE STAGES TO INTEGRATING GTD
1.  UNDERSTANDING  You understand the distinct differences in the five steps of Mastering Workflow. You 
understand a project versus a next action. You know how to transform what you’ve collected by asking the key 
processing questions, clarifying what something is, and what you want to do about it.

2.  IMPLEMENTATION  You have installed at least the basic gear to support a GTD system, including ubiquitous 
collection tools, functioning reference systems for your non-actionable information, and seamless buckets with 
“clean edges” for tracking your projects and next actions.

3.  BEHAVIOR CHANGE  The five steps of Mastering Workflow are second nature to you. You have changed the way 
you think and work and are achieving stress-free productivity on a regular basis. When you “fall off” you know 
what to do to get “back on.”

This Guide will leap forward to the “Implementation” stage, by configuring OmniFocus as an organizing tool for your 
projects, actions, and reference. Success at the implementation stage depends on your understanding of GTD.

If you are committed to GTD and experiencing stress-free productivity, don’t shortchange yourself by skipping the 
“Understanding” stage.

UNDERSTANDING THE GTD BEST PRACTICES
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THERE ARE MANY WAYS TO GET A BASIC UNDERSTANDING OF GTD, INCLUDING: 

Read or listen to the book  Getting Things Done is the essential manual for this methodology (part one is an 
excellent overview of the whole game).

Take a course  The courses offered by our global partners around the world are excellent primers for understanding 
the key steps of Mastering Workflow.

Practice, practice, practice  The GTD Workflow Map (shown below) is a fantastic coaching tool for walking 
yourself through the core models for capturing, clarifying, organizing, reflecting, and engaging.

THE GTD WORKFLOW MAP

 
 

 
 
 
 

Areas of Focus
and Accountability 

Goals

Vision

Purpose

Someday / Maybe lists / folders

Recycle, shred, delete

Date-specific triggers

Paper / digital – lists / folders

Possible
later
action 

WHAT’S THE
DESIRED OUTCOME?
(If multi-step)

TRASH

REFERENCE

If less than 2 minutes

DO IT

IS IT ACTIONABLE?

WHAT’S THE 
NEXT ACTION? INCUBATE

DELEGATE

DEFER IT

WHAT IS IT?

PROJECTS

Project Support Material 
(review for actions)

For me to do, specific to a
day or time (calendar / tickler)

For me to do, as soon as I can 
(Next Actions lists / folders / trays)

In communication system and being 
tracked on Waiting For list / folder

We recommend getting the full Workflow Map, with all of the GTD models, which comes as PDF download.  
Visit our online store at gettingthingsdone.com/store to learn more.

UNDERSTANDING THE GTD BEST PRACTICES
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The purpose of this Guide is to equip you with our best practices for using OmniFocus as your GTD system for 
lists. This Guide is not about teaching you every feature of OmniFocus, or even using all of the features in the 
way The Omni Group intends, as we have found some features to be counterproductive to the GTD methodology 
(e.g., forcing all actions to be associated with a project, assigning deferred start dates on next actions, and 
relying on flagging items to get your attention.) What we will coach you through are the essential features we 
would use ourselves and teach our clients, to build a seamless and sustainable GTD system for lists.

KEY AREAS OF OMNIFOCUS 
It’s important to understand the differences among the three key areas of OmniFocus that we will be working 
with in your GTD system.

�Inbox – For collecting new, unprocessed input. This maps to the “Capture” phase of GTD. 
Example: “Idea: I want to take a vacation”

Projects – For tracking projects/outcomes. We will also adapt this section to store Reference 
information. This maps to the “Organize” phase of GTD. 
Example: “Project Outcome: Take vacation to Tahiti”

Tags – For tracking next action lists. These will be your day-to-day lists for choosing actions  
to complete. Context refers to the person, place, or tool you will need to complete the action.  
This maps to the “Organize” phase of GTD. 
Example: “Next Actions: Search online for Tahiti hotels” and “Buy new suitcase for Tahiti”

�Forecast – For viewing projects and actions coming due, as well as calendar entries if you are syncing 
your calendar.

Flagged – Used sparingly and kept current, the Flagged view can be an effective way to see specific 
items you choose to focus on.

Review – Feature to support you in effectively completing your GTD Weekly Reviews. 
 

INBOX FUNDAMENTALS 
yy Items in the inbox represent inputs you have not yet processed or organized (David Allen calls  

this “stuff”). To create trustworthy inboxes for collecting potentially meaningful input, you need  
to empty them regularly.

yy Processing your inbox means making decisions about what each input means and what you are 
going to do about it (see Workflow Map for how this is done).

yy Use the Quick Entry window (Control Option Space) to do a GTD Mind Sweep2 to capture what has 
your attention.

yy Use the OmniFocus Clippings or Mail Drop features to send information from other applications 
directly into your OmniFocus Inbox. Configuring both of these features is explained in the section  
of this Guide on Configuring OmniFocus.

2 The Mind Sweep is a GTD process for capturing what has your attention. Refer to the Getting Things Done book for helpful Mind Sweep trigger lists.

UNDERSTANDING THE GTD BEST PRACTICES
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PROJECT FUNDAMENTALS
yy Projects in GTD are defined as outcomes that will require more than one action step to complete 

and that you can mark off as finished.

yy Your Projects list serves as a master index of the projects you are committed to completing within 
the next 12 months—think of your Projects list as a current table of contents of the current 
outcomes on your plate.

yy In OmniFocus, projects are stored in the Projects section.

yy The typical number of projects for most people we work with ranges from 10 –100, personally and 
professionally. Current projects have at least one next action, waiting for, or calendar action, in 
order to be considered current.

yy Projects that have no current next action, waiting for, or calendar action are either no longer 
projects for you (completed or dropped), or should be incubated to Someday/Maybe.

yy Future actions (i.e., actions that are dependent on something else happening first) do not go on 
the Next Actions (Tags) lists until you can take action on them. Even though OmniFocus allows 
you to enter a start date, we do not recommend using this feature, so that your Next Action lists 
truly represent a clear view of your current action choices only.

yy The Projects list and project plans are typically reviewed in your Weekly Review, ensuring each 
project has at least one current next action, waiting for, or calendar item.

yy It’s fine to have multiple next actions on any given project, as long as they are parallel and not 
sequential actions (e.g., “Buy stamps” and “Mail invitations” would not both be on Next Actions 
lists for the “Put on Party for David” project given that 
you need to buy the stamps before you can mail the 
invitations).

yy Projects are listed by the outcome you will achieve when 
you can mark it as done. (What will be true?)

yy Effective project names motivate you toward the outcome 
you wish to achieve, and give you clear direction about 
what you are trying to accomplish.

TAGS FUNDAMENTALS 
yy In OmniFocus, Next Action lists are stored in the Tags section. In previous versions of OmniFocus, 

these were called Contexts.

yy Next actions are defined as the physical, visible steps required to get something done and 
describe what you want to do to move toward a successful outcome.

yy Your Next Action lists serve as the day-to-day 
working lists of your action choices.

yy We recommend organizing your Tags by context, 
which David Allen says should map to the people, 
places, and tools you need to complete the action.

yy Next Action lists are reserved for your next actions 
only—not sequential or dependent actions that 
require something else to happen first.

Examples of Projects Defined  
by the Outcome:

- Roll out leadership initiative

- Take summer vacation

- Buy a new car

Examples of Next Actions Defined by 
the Next Physical, Visible Step:

- �Email Mike about budget for 
leadership initiative off-site meeting

- �Research online for hotels for 
summer vacation

- Test drive the new Tesla
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yy It’s common to have multiple actions you can do in parallel on any given project.

yy Next actions should start with a verb, clearly describing what you will do. (E.g., Call, Read, Write, 
Email, Edit, Talk to, Outline, etc.)

yy Projects that do not have at least one current next action, calendar item, or waiting for should be 
marked complete, deleted, or incubated to Someday/Maybe.

yy Not every next action, calendar item, or waiting for is related to a project. (E.g., “Buy shampoo” 
doesn’t mean you have to create a project called “Wash my hair.”)

yy OmniFocus will force you into linking every next action to a project, but we will show you an easy 
workaround for that by creating a “---” project, as a placeholder.

yy Next Action lists are to be reviewed as often as you can.

yy Effective next action descriptions attract you more than repel you toward completing the action.

THE MOST COMMON GTD LISTS 
There are 10 lists recommended in the Getting Things Done book that are a good starter set for most people.

yy Next Actions:

–– Agendas

–– Anywhere

–– Calls

–– Computer

–– Errands

–– Home

–– Office

yy Waiting For

yy Someday/Maybe

yy Projects

NOTE:  Some of these won’t match the settings that come pre-populated in OmniFocus. We’ll walk you through 
setting these up in the next section.

Agendas – This list tracks the topics and agenda items for people you interact with regularly. For example,  
if you have a standing meeting with a particular team, and want to capture agenda items to bring up at the next 
meeting, this is the place to capture them. 

You can organize agendas two ways: 

1.	 Add the person or team name in the subject line and use the note field to capture your agenda items. 
	 With this method, you only have one agenda entry per person or team. 
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	 The advantage with option one is that all of your agenda items are parked in one place, which can be easier  
	 to retrieve and/or print as one page before you go into a meeting. 

2. 	 Create a separate list (tag) for each person/team. With this method, you would have many items on your 	
	 Agenda list, representing all of the different agenda items you need to track. 

	

	 The advantage with option two is usually creating entries faster by simply creating a new Task, versus 		
	 navigating to the agenda entry you need and adding your item to the note field, as described in option one. 

The Agenda list is not for tracking next actions that you need to take related to that person or team (for example,  
a call you need to make to that person, which would instead go on your “Calls” list.) Once you’re on the call, you 
may refer to the Agenda list for that person, but it’s the Calls list that triggers the action to make the phone call,  
not Agendas. 

You could easily have a dozen people and meetings that you are tracking this way—your direct reports, your 
boss, your assistant, your spouse, the weekly staff meeting, the monthly board meeting, etc. Just be careful you 
don’t create so many Agenda lists that it becomes difficult to find what you need and keep them current.

NOTE:  Instead of Agendas, OmniFocus calls this People; People: Boss, and People: Spouse in the default set of Tags.

Anywhere – An action that can be accomplished, without any restriction about where it’s done, would go on 
this list. Typical examples would be: Draft ideas re: family vacation (if you like doing that by hand with pen and 
paper instead of at the computer) or Draft ideas for new team structure.

 

NOTE:  OmniFocus does not include Anywhere in the default set of Tags. We recommend you add it, in the section of this 
Guide on Configuring OmniFocus.

Calls – Place reminders of calls you need to make in this category, if they can be made from any phone. If you 
are highly mobile, take the time to type or cut and paste the phone number on the subject line as well.

NOTE:  OmniFocus includes a default Tag called Phone. You can use that, or rename it to Calls.
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Computer – If the action requires a computer (emails to send, documents to edit or draft, spreadsheets to 
develop, websites to visit, data to review, etc.), place it here. This list then comes into play whenever you are at 
your computer(s) with any discretionary time. Even if you only have a computer in the office, it’s still convenient 
to have this list separate from your Office list of things to do, because you wouldn’t need to look at this list when 
the server is down or you are looking for non-computer things to do. 

 

NOTE:  The default OmniFocus Tags include a number of variations on the Computer list idea, including Computer, Online, 
Device, and Email. We recommend getting by with as few of these as you can, but as many as you need. We cover how to 
customize these in the Configuring OmniFocus section.

Errands – This holds reminders of things that you need to do when you are “out and about” (stop by the bank, 
take something to the tailor, buy something at a store, etc.). If you are likely to think of more than one thing to 
do or get at one of those locations (like the hardware store), make “Hardware store” the Subject and put your 
running list of things to get/do there in the Notes field below.

If you are a regular road warrior you might consider having two errands lists—one for things you could do 
anywhere, in any city, and one for errands that need to be completed where you live.

NOTE:  Again, the default Tags included in OmniFocus are a little different. They include Grocery Store and Apple Store. 
You can customize these to use just one Errands list or change the names to locations specific to you.

Home – This list is for next actions that have to be done in your home environment (gather tax receipts, repair 
the cabinet door, clean up the tool shed, etc.). It would also hold reminders of calls that you have to make, if you 
have to be at home to make the call.
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Office – These are the next actions that require you to be at your office, such as calls that you have to make 
from your desk because of the materials you need for the call. Purge your files, review information stored in your 
office, scan some documents, and look something up in the corporate library would also be examples of the 
kind of items you would want to have on this list.

 

Waiting For – This list keeps track of all the actions, projects, and deliverables that you want to happen, but 
which are someone else’s responsibility. It could be something you’ve ordered that hasn’t come yet, something 
you’ve handed off to your assistant for which you’re waiting on a response, or something your boss is supposed 
to be finding out before you can move forward on a key project.

 

We suggest adding the date you started waiting in the description of the item. This can be helpful when 
deciding when it’s time to follow-up again, if they have not responded.

The Waiting For list should be reviewed as necessary (at least once a week in the GTD Weekly Review® 3), 
triggering appropriate actions on your part to follow up, light a fire, or just check the status.

Someday/Maybe – These are the things you might want to do at some point in the future, but with no 
commitment to move on them at present. 

NOTE:  Some people prefer to keep the Someday/Maybe list in the Projects section. Really, either place works—Tags  
or Projects. Experiment with whichever works best for you.

3 The GTD Weekly Review is the recommended process for getting your workflow clear and current, so that you can get creative. Refer to the Getting Things Done book    
   for a helpful Weekly Review checklist.
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Projects – Any of your desired outcomes that will require more than one action step to complete, which you 
expect will be done over the next 12 months.

The Projects list should be reviewed weekly in the Weekly Review, and should include reviewing your project 
plans and capturing any new next actions for your Tags lists.

CUSTOMIZING YOUR TAGS
The categories we have suggested should serve as a starting point. You may need fewer or more Tags than we 
suggest. Do not feel tied to the 10 we are suggesting or the default ones in OmniFocus. That said, the 10 we 
suggest are a great way to start, if you’re new to GTD. 

Remember, contexts (Tags in OmniFocus) map to the people, places, and tools you need to get work done.  
Be willing to experiment to find the set that will work best for you. In the next section, on Configuring 
OmniFocus, we’ll show you how to change the Tags built into OmniFocus to adapt them for your needs.
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CONFIGURING OMNIFOCUS

CONFIGURING OMNIFOCUS

These one-time configuration changes, broken down into some simple steps, should take you about 20 minutes  
to complete. We recommend these changes to adapt OmniFocus to the optimal configuration that best supports  
a GTD system.

PROJECTS AND NEXT ACTIONS
CONFIGURE DEFAULT PROJECT TYPES
OmniFocus allows two different types of projects to be created: Parallel or Sequential. Parallel means you can 
create multiple next actions for any given project and all of those next actions, if assigned a Tag, will appear  
on your Next Action Tags lists. 

Sequential assumes you only have one next action for any given project, and even if you have a Tag assigned  
to other next actions for that project, only the first one listed will appear in Next Actions. With Sequential, 
additional next actions will only appear on Next Actions when you complete actions one by one. For this reason, 
we recommend only using the Parallel type for all of your projects.

With the Parallel type, you will have the most flexibility in working with your projects and completing actions.  
We have found the Sequential type to be far too limiting for most people’s needs, by forcing you into only one 
next action. It also makes a false assumption that the next listed next action under your project is the actual 
next one. That may not be the case at all. Have you ever known, when starting a project, exactly what the steps 
are in the project, in the exact order that those actions should happen, with no new variables along the way?  
It’s unlikely. Therefore, we always recommend you choose Parallel as the type, when creating projects  
in OmniFocus, to give you the most options in choosing what to do.

1.	 Go to the Projects section of OmniFocus.  

2.	� Under OmniFocus > Preferences > Organization, be sure Parallel is the default project type when creating  
new projects:

	

	 Parallel projects will show this symbol in your Projects list:

	 Sequential projects will show this symbol in your Projects list:

	� Single-Actions lists (ideal for general Reference) will show  
this symbol in your Projects list:	
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The project type can be changed in the Type field in your project details:

Before leaving the Organization preferences, change Clean up inbox items...to Either a Project or a Tag and 
change Clean up changed items to Immediately:

CHANGE MISCELLANEOUS PROJECT NAMES
OmniFocus assumes every next action is related to a project (which will not always be true). Therefore, next 
actions you create in OmniFocus that you do not manually assign to one of your projects will be automatically 
assigned to a preset project called “Miscellaneous” by default, if you have changed the setting above to Clean 
up items which have a Tag (Miscellaneous is not created if you left that setting as Project). We suggest changing 
the name from “Miscellaneous” to “---” to make this project name more accurate (“---” implying “none”) and to 
make your lists more visually appealing to work with.

1.	 Go to the Projects section of OmniFocus.  

2.	� Double click on the project named “Miscellaneous” to be able to edit the project name (if you do not have  
a project named “Miscellaneous,” see next page).

	

	

 
	

	 Change “Miscellaneous” to “---” instead.
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If you do not have a project named “Miscellaneous,” click on the + sign in the toolbar to create a new action. 
Add a new action (even a sample placeholder for now), assign it to a Tag (such as Online), but do not assign  
it to a project. Click Save. Go back to Projects and you should now see “Miscellaneous” as a new project. 
Change the name to “---” as described on the previous page.

CUSTOMIZING YOUR TAGS FOR GTD
The next step is to determine which lists will work for you. The Getting Things Done book recommends 10 lists  
to get started:

yy Next Actions:

–– Agendas

–– Anywhere

–– Calls

–– Computer

–– Errands

–– Home

–– Office

yy Waiting For

yy Someday/Maybe

yy Projects

You’ll be setting these lists up as Tags in OmniFocus (except Projects, which have their own section in OmniFocus.)

Some of our recommended lists already exist in OmniFocus. Version 3 comes pre-populated with:

––  Errands: Grocery Store

––  Errands: Apple Store

––  Home

––  Office

––  Device

––  Computer

––  Online

––  Email

––  Phone

––  People

––  Waiting
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Add New Tags

1.	 Go to the Tags Perspective.  

2.	 Click the plus icon toward the bottom left of your window to create a new Tag.  

	

 
	

3.	 Enter Someday/Maybe as a new Tag. Repeat this step for any new lists you need to create.

To change any existing Tag names, double click on the current name and type in the new name. 

To delete a Tag, highlight the Tag name and press delete on your keyboard. If you have actions assigned  
to a Tag you are deleting, they will go to the Untagged Perspective.

To change the order of any Tag, highlight the Tag name and drag it up or down in the list. Be careful where you 
place it, as it’s easy to “drop” it as a sub-list of another list rather than placing it as its own top-level list. 

Take a moment to also change the “Waiting” list to Active. 
By default, OmniFocus sets the status for this list to On Hold. 
We have found the best way to work with all of your Tag lists 
for GTD is to consider them Active.

SETTING TAG VIEWS
One more setting to check is that your Tags Perspective is set to “Remaining.” This will ensure that your full 
inventory of next actions appears correctly, which is important when you are deciding what to do.

1.	 Select View in the OmniFocus toolbar.  

2.	 Select Availability Filter > Remaining.  
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CUSTOMIZING YOUR TOOLBAR
For easy access to the OmniFocus features you will 
use most often, be sure your Toolbar is set how you 
need it. 

Go to View > Customize Toolbar. The icon we 
recommend adding in particular is Quick Entry,  
if it’s not already in your Toolbar.

SETTING UP CLIPPINGS
The OmniFocus Clippings feature can be a useful addition to your workflow. It allows you to copy text from other 
applications and quickly create a new entry in OmniFocus. This can be particularly useful in email, to grab next 
actions out of an email that should go on to your Next Actions lists. You’ll also likely find it useful when browsing 
the web when you come across useful reference information you want to save with your Reference lists in 
OmniFocus. To use this feature, you’ll need to create a keyboard shortcut for Clippings, if you haven’t already 
done so.

In the OmniFocus menu, go to OmniFocus > Preferences > General tab. Click on Set Shortcut, which will launch 
two new windows: OmniFocus Help instructions about Clippings and a Macintosh system window to set your 
shortcut. Go to the window for setting the shortcut, which will look like this:

 
 

In that window, you should see two panes: on the left is a list of shortcut categories, and on the right is an 
outline of items within that category. In the left pane, click on Services, and on the right scroll down until you 
see the group of Text services. In there, you should see an item for the OmniFocus Send to Inbox service. Click 
on that service, and an add shortcut button should appear, which you can use to assign a keyboard shortcut.



© 2014, 2018 David Allen Company. All rights reserved.  827-LTR  14NOV2018    gettingthingsdone.com 16CONFIGURING OMNIFOCUS

To use the Clippings service:
yy Highlight the text in another application, such as your email or browser.

yy Use the Clippings keyboard shortcut you created to copy the text, or open that application’s menu (top left) 
> Services > OmniFocus: Send to Inbox.

yy A new item, with the highlighted text is inserted into a new OmniFocus Quick Entry window. Make any edits 
needed and save.

SETTING UP MAIL DROP
Another way to capture information in OmniFocus is with Mail Drop. This handy feature of the Omni Sync Server 
allows you to address emails to a special email address, created for you by The Omni Group, and have that 
email appear in your OmniFocus Inbox. To set up Mail Drop go to: https://manage.sync.omnigroup.com/

Navigate to the Mail Drop field and select Create Address and follow the simple instructions that follow.

Be sure to copy and add your new Omni Sync Server address to your address book for use later.

Ways to use Mail Drop:

yy Quick capture of Mind Sweep items

yy Quick capture of new Next Actions 

yy Quick capture of new Projects

yy Forwarding emails from your email client that need to be processed onto your Next Actions, Projects,  
or Reference Lists

CREATING EMAIL SUPPORT FOLDERS
Whether you use the Clippings Service or not, it’s easy to integrate email with OmniFocus. A simple 
recommendation is to create two folders as subfolders in your email Inbox:
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Think of these folders as “storage tanks” holding the email until you can take the action or complete the waiting 
for. We recommend you create the same two folders for your hard copy data. As paperless as you may think 
you are, you’ll be surprised by the random hard copy things you’ll still need to track, and having an analog 
system that matches your digital system will come in handy.

For example, OmniFocus will track your next actions, while Support folders (in email and hard copy) will serve 
as “storage tanks” holding the supporting information you need to complete those actions.

INTEGRATING WITH YOUR CALENDAR
While OmniFocus will serve as an excellent list manager, a calendar in another application will still be a critical 
piece of your workflow. 

A helpful way to think of the difference between what is stored in your Calendar versus OmniFocus is:

Calendar = Stores actions that need to be completed ON a day (e.g., Call Todd on Friday)

OmniFocus = Stores actions that need to be completed BY a day (e.g., Call Todd by Friday) or on ANY day  
(e.g., simply Call Todd)

You may also find it useful to link your calendar to OmniFocus, to take advantage of the Forecast feature. This 
will enable you to view projects and actions coming due, as well as upcoming calendar entries.

To enable OmniFocus to access your calendar, go to your Mac’s System Preferences > Security & Privacy > 
Privacy > Calendars and check off OmniFocus.

SYNCING TO IPAD® AND/OR IPHONE®

In our experience, OmniFocus syncs beautifully with iPad and iPhone devices. You will need to purchase 
separate versions of OmniFocus for each device, through the iTunes store. We recommend you invest in at least 
one of those options, as having mobile access to your lists can make the difference between functional and 
non-functional lists, (e.g., if you’re creating lists for Tags such as Errands or Home, but then don’t have those 
lists with you in those contexts, they won’t be useful for you unless you are printing them).

To configure the syncing between your devices, go to OmniFocus > Preferences > Synchronization tab.  
Choose the type of syncing that works best for you. Many people choose the free Omni Sync service.
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There are some slight differences in how the same information will be displayed across the different devices,  
but OmniFocus is intuitive enough that this shouldn’t be an obstacle for you.

USING THE WEB VERSION OF OMNIFOCUS
The new OmniFocus for the Web version is a handy companion to OmniFocus desktop. It will be useful for those 
times when you want a larger view of your OmniFocus data, but don’t have access to your computer.

Desktop view:	                  Web view:

What’s the same:

Inbox, Projects, Tags, and Flagged views are essentially the same on the desktop and web versions.

What’s different:

Desktop shortcuts, toolbar layout and icons, menus, Forecast, and Review are not (currently) available on the 
web version.

 

USING SIRI WITH OMNIFOCUS
A handy feature for iOS users is to engage Siri to capture items for OmniFocus. This works by using the native 
Reminders app on the iPhone/iPad as a gateway to copy items to OmniFocus. Once enabled, phrases such as:
“Siri, remember to…” or Siri, remind me to…at (date and time),” will be ported into OmniFocus. 

To configure Siri for OmniFocus and to read more about this feature, visit the OmniFocus website at:  
https://support.omnigroup.com/documentation/omnifocus/ios/3.1.1/en/interacting-with-siri/
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POPULATING OMNIFOCUS

POPULATING OMNIFOCUS

You are now ready to start populating OmniFocus with your work. 

ADDING NEW PROJECTS AND RELATED ACTIONS
Let’s start with an easy sample project so you get the idea.

1.	 Click on the Projects button in the Toolbar.

2.	 Click on the + icon in the lower left hand corner of your OmniFocus window and select New Parallel Project.

3.	 Describe the desired project outcome in the Project Name (use “Take vacation to Tahiti” for this example).

	  
	

4.	 Highlight the new project in the Projects list and click the + sign in the toolbar or use the keyboard shortcut 	
	 ⌘ N.

 
	

5.	� Now enter the four actions listed below for this sample project. Pressing Enter/Return twice after each one 
will bring you to a new field.
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Looking at this list, only three of these are potentially next actions that can be done in parallel, whereas one 
(Pack for Tahiti) is dependent on the others happening first, and is technically a “future” or “sequential” action. 
In other words, you can’t pack until you’ve bought the new suitcase. So, in this example, only the three you can 
take action on now will be assigned Tags and will appear on your Next Actions lists.

This is a critical GTD learning point to understand, as it ensures your Next Action lists in Tags remain active, 
functional lists showing only the choices for action you can take now. All future actions remain listed with your 
project, without a Tags assigned to them, until you can take the action.

Add those Tags now by clicking on the drop down menu next to each of those and assigning the appropriate 
Tag to them.

As soon as you are able to take action on Pack for Tahiti,  
simply come back to this list for this project and assign it a Tag. 
Until then, it will be stored here and be considered part of your 
project plans.

In order for this method to work correctly, and for all of your 
current next actions to appear in your Tags Perspective for Next 

Actions, the project must be created as a “Parallel” project (see the  icon in the example above indicating 
Parallel type, described in more detail on page 11) and your view in Tags set to “Remaining” (as described 
earlier in the Guide).

ADDING NEW NEXT ACTIONS AND LINKING TO THE RELATED PROJECT
You can also add next actions and assign them to projects directly from the Tags section. 

1. 	 Click on the Tags icon in the Toolbar.

2. 	 Click on the Quick Entry icon in the Toolbar, or use the keyboard shortcut Control Option Space.

3. �	 Enter a new next action for your Tahiti project (e.g., “Buy sunscreen”). Assign it to the “Take Tahiti…” project 	
	 and the Errands list. OmniFocus will suggest a list if you start typing the first few letters in the column for 	
	 your selection.

	

	

4. 	 Click Save or press Enter/Return when done.
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ADDING NEW NEXT ACTIONS NOT RELATED TO PROJECTS
Not every Next Action will be related to a Project. OmniFocus’s design, however, is to associate all actions to a  
pre-set project called “Miscellaneous.” That’s why, earlier in the Guide, we asked you to change Miscellaneous  
to “---.” If you didn’t make that change page on page 12, we recommend you do that now.

1. 	 Click on the Quick Entry icon in the Toolbar, or use the keyboard shortcut Control Option Space.

2. 	 Enter your Next Action (“Send flowers to mom”), don’t assign a project, but do assign it a Tag.

	

3. 	 Click Save when done. (You can also hit Enter/Return.)

4. 	� In the Tags Perspective, this will appear under the Tags list you assigned to this next action and in the 
Project Perspective, this will appear under the project “---”.

NOTE:  You can also use the + icon in the Toolbar to create new next actions, which will create new items for whatever 
list you have highlighted in the left margin. Be careful with this, as it’s easy to start adding actions to the wrong Tag.  
If you do that, you can simply drag and drop them to the correct list or adjust the Tag in the drop-down menu.

CREATING PROJECT FOLDERS 
Another option for organizing your projects in OmniFocus is to sort them into folders. For example, you may 
want to separate your Personal from your Work projects. Or, sort them by your Areas of Focus/Responsibilities, 
as described in David Allen’s Horizons of Focus® model. The advantage of this kind of sorting is that it gives you 
an easy way to focus on a particular area of your work or life. For example:

Sorted by Work/Personal:	                     Sorted by Areas  
			          of Focus:

To create new folders, click on the + sign in the bottom left-hand corner of OmniFocus and choose New Folder. 
You can move your Projects into folders and change the order of your new folders by simply dragging and 
dropping them into the order you prefer.
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CAPTURING NOTES
Both Tags and Project entries include a handy note field for capturing additional 
information, such as text, hyperlinks, and file attachments. This can be helpful 
when you want to add details that don’t belong in the subject line (which is typically 
reserved for your project name or next action). You can view, add, or edit your 
notes by clicking on the entry and viewing the note box in the right panel. For 
example, here are notes associated with an Agenda list:

If this Note field is not appearing for you in the right margin, click the Inspector 
Sidebar icon in the toolbar.

STORING REFERENCE
We have found that the Projects section works well to store various reference lists and checklists. For example,  
a common checklist recommended in GTD is the travel checklist. A great place to park this is in the Projects 
section, created as a Single Action list. To do this, go to the Projects Perspective. Select the + sign in the lower 
left corner and choose New Single Action List. Name your list.

 

There are two options for adding items to this list: 

1.	 Add the items in the Note field for that list name:        2.  Add them as new actions assigned to that list:
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To get started, here are some possible reference categories and lists to play with:

	 Checklists	 Clients 
	 Areas of Focus	 Fun 
	 Ideas	 Great quotes 
	 Inspirations	 Might like to read 
	 Might like to buy	 Next time in… 
	 Music to download	 Vacation ideas 
	 Travel	

If you create a number of these Single-Action lists for reference, you may find it helpful to group them together  
in a folder called Reference. For example:

 

PROCESSING ITEMS IN THE OMNIFOCUS INBOX
Your inbox gathers unprocessed items—in other words, items for which you have not clarified, “What’s the 
outcome?” and “What’s the next action?” It’s a fantastic tool to use when doing the GTD Mind Sweep to capture 
what’s grabbing your attention, without always having to stop to process and organize the item. You can stay in 
the flow of your work, and still have a trusted bucket into which you can empty your head.

If you use the Quick Entry form for a new item, but do not assign it to a project or next action, it will be sent 
to the Inbox in OmniFocus. If you use the “Clippings” feature in OmniFocus (mentioned on page 15 of this 
Guide), those items will also appear in your Inbox, if you did not assign a Tag or Project. To process Inbox items, 
highlight the item in the Inbox, edit the subject line to capture your next action (remember to include a verb),  
assign it to a project if applicable, and select the Tags list required to take the action.

For example, let’s clarify the item Cards that was captured:
 

 

1. 	 Highlight the item in the Inbox.

2. 	 Edit the subject to accurately describe the next action and assign a Tag. If the item is related to a project, 	
	 choose a project as well.

	

3. �	 As soon as you click away from the Inbox, or use the keyboard shortcut ⌘ K, the item will be removed from 	
	 the Inbox and get moved to the Tags or Project list you assigned it to.
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DUE DATES OR NO DUE DATES?
Our recommendation is to use due dates so that you trust them. In other words, use them carefully, so that 
when you see them they are actually a motivator and an accurate reflection of your choices. Many people get 
into the habit of due-dating everything to death, which leads to not really trusting any of them. Even though 
OmniFocus allows you to enter a start date, we do not recommend using this feature, so that your Next Action 
lists truly represent a clear view of your current action choices only.

MARK COMPLETE VERSUS DELETE
Whether you mark an item complete or delete it is entirely up to you. Many people find that keeping a list of 
completed projects is very useful, especially for year-end reviews. You may not need that same level of tracking  
with your next actions. 

On the other hand, if it serves no harm and you have the space on your computer, there’s no reason to delete 
what might be useful to recall someday or remind you of the excellent work you’ve completed.

THE GTD WEEKLY REVIEW TIES IT ALL TOGETHER
Any tool you use will take effort to keep clean and current, so that you can trust your action choices. OmniFocus 
is no exception. Rest assured, the GTD Weekly Review is what ties this whole thing together, ensuring that you 
have actions on all the active parts of your projects on a consistent basis, so you can trust that what you are 
choosing from your next action lists is current. The Weekly Review steps include:

	 GET CLEAR
	 Collect Loose Papers and Materials  
	 Get “IN” to Zero 
	 Empty Your Head

	 GET CURRENT
	 Review Action Lists 
	 Review Previous Calendar Data 
	 Review Upcoming Calendar 
	 Review Waiting For List 
	 Review Project (and Larger Outcome) Lists 
	 Review Any Relevant Checklists

	 GET CREATIVE
	 Review Someday/Maybe List 
	 Be Creative and Courageous
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OmniFocus has a Review function built-in with our GTD Weekly Review in mind. We don’t consider this to be  
an essential feature of OmniFocus for your doing your GTD Weekly Reviews, but it can be a useful piece to try. 
Please note—using this feature does not replace what we consider to be the complete GTD Weekly Review.  
It’s simply helping to facilitate reviewing Action, Project, and Waiting For Lists, in our checklist above.  

To use the Review feature, click on the Review icon in the Sidebar. 

You should see a list of your current unreviewed projects. If you don’t see any projects, you can drag one from 
your Projects view to play around with this feature. Review each one, ensuring each one has a current next 
action and any actions you’ve finished are marked complete. This is where you would assign any “future” 
actions to Tag lists if they can be done now. If they are still a future action, they remain where they are, with  
no Tag assigned, until your next review of that project.

When you have completed reviewing a project with the Review feature, click the Mark Reviewed button to log 
the date of your last review in the Review box in the details panel for that project. (The Mark Reviewed button 
only applies to the overall Project, not the Next Actions under that Project.)

 

SAVING TIME WITH KEYBOARD SHORTCUTS
Studies show you’ll be four times faster using the keyboard shortcuts than reaching for your mouse or trackpad. 
If you aren’t using them already, learn the keyboard shortcuts in OmniFocus for the functions you use most.  
The list of keyboard shortcuts is extensive. Instead of listing them all here, we recommend browsing to  
Help > OmniFocus Help > Menus Commands and Keyboard Shortcuts to see which ones could be useful for you.
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ADDITIONAL RESOURCES
We hope this instruction guide has been useful. It is intended as a supplement to our core education of workflow 
mastery developed over many years—not a substitute. The most successful implementation of this guide builds 
on the understanding of the GTD best practices presented in our many learning tools, including the Getting 
Things Done book, the courses and individual coaching offered by our global partners, and our online learning 
center GTD Connect®. 

Please visit our website to take advantage of the many support tools and training available to assist you in getting 
your GTD system up and running.

FOR TECHNICAL SUPPORT WITH OMNIFOCUS, PLEASE VISIT:

support.omnigroup.com 

FOR MORE INFORMATION ABOUT GTD, PLEASE VISIT:

gettingthingsdone.com 

gtdconnect.com 

CONCLUSION

CONCLUSION




